
BAB II 

LANDASAN TEORI 

 

2.1 Rancang Bangun 

Hasyim (2014,) menguraikan bahwa perancangan merupakan salah satu hal yang 

panting dalam membuat program.Adapun tujuan dari perancangan ialah untuk 

memberi gambaran yang jelas dan lengkap kepada pemrogram dan ahli teknik 

yang terlibat.Perancangan harus berguna dan mudah dipahami sehingga mudah 

digunakan. Perancangan atau rancang merupakan serangkaian prosedur untuk 

menterjemahkan hasil analisa dari sebuah system ke dalam bahasa pemrograman 

untuk mendeskripsikan dengan detail bagaimana komponen-komponen system 

diimplementasikan. 

 

Hasyim (2014) menguraikan bahwa rancang bangun adalah penggambaran, 

perencanaan, dan pembuatan sketsa atau pengaturan dari beberapa elemen yang 

terpisah kedalam suatu kesatuan yang utuh dan berfungsi.Dengan demikian 

pengertian rancang bangun merupakan kegiatan menerjemahkan hasil analisa ke 

dalam bentuk paket perangkat lunak kemudian menciptakan sistem tersebut atau 

memperbaiki sistem yang sudah ada. 

 

2.2 Aplikasi 

Aplikasi menurut Jogiyanto (2008), adalah program yang telah jadi dan siap 

digunakan atau program yang dibuat sendiri. Aplikasi berasal dari kata 

application yang artinya penerapan, lamaran, penggunaan. Secara istilah aplikasi 

adalah program siap pakai yang dibuat untuk melaksanakan suatu fungsi bagi 

penguna atau aplikasi yang lain dan dapat digunakan oleh sasaran yang dituju. 
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2.3 Black-Box Testing 

S, Rosa & M (2016) menguraikan bahwa Black-Box Testing (Pengujian Kotak 

Hitam) yaitu menguji perangkat lunak dari segi spesifikasi fungsional tanpa 

menguji desain kode program.Pengujian dimaksudkan untuk mengetahui apakah 

fungsi-fungsi, masukan, dan keluaran dari perangkat lunak sesuai dengan 

spesifikasi yang dibutuhkan. 

  

2.4  Adobe Flash 

Pramono Andi (2005) menyatakan bahwa Adobe Flash CS3 adalah satu software 

dari perusahaan adobe, Inc. yang banyak diminati oleh kebanyakan orang karena 

kehandalannya yang mampu mengerjakan segala hal yang berkaitan untuk 

pembuatan film kartun, banner iklan, web site, presentasi, game, dan lain 

sebagainya. Selain itu flash juga dapat dikombinasikan dengan program yang lain, 

misalnya grafis seperti AutoCAD, Photoshop, Camtasia dan lain sebagainya. 

Selain itu flash juga dapat dikombinasikan dengan bahasa pemrograman, seperti 

ASP, PHP, dan sebagainya”.    

 

Kehandalan adobe flash CS3 dibandingkan dengan program lain adalah dalam hal 

ukuran file dari hasil animasinya yang kecil, untuk animasi yang dihasilkan oleh 

program adobe flash CS3  banyak digunakan untuk membuat sebuah web agar 

menjadi tampil lebih interaktif (Bunafit Nugroho 2008).  

 

Madcoms (2012), Adobe Flash Profesional CS6 adalah salah satu perangkat lunak 

komputer yang merupakan produk unggulan Adobe System. Adobe Flash 

Profesional CS6 merupakan software yang digunakan untuk menciptakan animasi 

dan konten multimedia. Desain pengalaman perancangan progaraminteraktif yang 

hadir secara konsisten di seluruh desktop dan beberapa perangkat, termasuk tablet, 

smartphone, dan televisi. Dengan Adobe Flash Profesional CS6 kita dapat dengan 

mudah menggabungkan beberapa simbol dan urutan animasi menjadi lembaran 

sprite tunggal dan dioptimalkan untuk alur kerja yang lebih baik, dibuat lebih 

menarik dengan konten menggunakan ekstensi asli untuk mengakses kemampuan 

perangkat secara spesifik. 
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Adobe flash CS3 (dahulu bernama macromedia flash) adalah hasil akuisi yang 

dilakukan oleh Adobe yang salah satu perangkat lunak komputer yang merupakan 

produk unggulan adobe sistems. Adobe flash memiliki kemampuan untuk 

membuat animasi mulai dari yang sederhana hingga kompleks. Adobe flash dapat 

menggabungkan gambar, suara, dan video ke dalam animasi yang dibuat. 

Kehandalan adobe flash CS3 dibandingkan dengan program lain adalah dalam hal 

ukuran file dari hasil animasinya yang kecil (Hasrul, 20118).  

 

Adapun area kerja pada Adobe Flash Profesional CS6 sebagai berikut : 

 

 

Gambar  2.1. Tampilan area kerja Adobe Flash CS6 

a. Toolbox 

Di dalam toolbox terdapat macam-macam tool yang bisa kita gunakan 

untuk menggambar objek. Toolbox ini terdiri dari beberapa bagian yaitu 

selection tool, drawing tool, painting tool, dan navigation tool. 

b. Timeline 

Timeline pada Adobe Flash CS6 secara default terletak diatas stage. 

Timeline  berfungsi untuk mengontrol keseluruhan objek dan animasi yang  

terdapat pada stage. 

c. Layer 

Layer dapat diilustrasikan seperti tumpukan-tumpukan yang berisi objek di 

dalamnya. Dengan layer, kita bisa mengatur movie pada stage dan 

a 

b c d e 
f 

g h 
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menentukan kedalaman atau lapisan suatu objek. Untuk menambahkan 

layer baru, kita dapat memilih menu Insert > Timenline > Layer atau 

dengan mengklik icon yang terdapat pada bagian bawah timeline. 

 

Terdapat beberapa mode yang dapat dipilih pada layer di ataranya : 

a. Guide layer, berfungsi untuk membuat animasi dengan menggunakan jalur 

atau track berupa garis yang telah dibuat. 

b. Motion layer, digunakan untuk membuat pergerakan animasi tween. 

c. Masking layer, digunakan untuk membuat animasi efek masking. 

d. Frame merupakan bagian dari layer yang digunakan untuk mengatur 

pergerakan animasi. Di dalam frame bisa terdiri dari teks, gambar, 

audio,video, dan kode program ActionScript. 

 

Frame terdiri dari beberapa bentuk, di antaranya : 

a. Keyframe, frame yang memiliki bentuk bulatan hitam, menandakan bahwa 

di dalamnya terdapat objek. 

b. Blank keyframe, frame berbentuk bulat putih, menandakan bahwa frame 

masih kosong. 

c. Action frame, frame dengan bulatan putih dan terdapat huruf „a‟, 

menandakan di dalamnya terdapat kode program ActionScript. 

d. Frame label,  yaitu frame yang diberi nama label dan ditandai dengan 

bendera warna merah. 

e. Stage 

Stage adalah area putih berbentuk kotak yang terletak ditengah area  kerja 

Flash. Seperti istilah stage pada panggung teater, stage di dalam Flash 

berfungsi untuk menampilkan semua objek maupun movie yang berjalan 

diatasnya. Objek yang diletakan pada stage bisa berupa teks, gambar, dan 

video. 

f. Panel Properties 

Panel ini menampung semua properti yang terdapat pada tool-tool dalam 

Flash. Untuk mengaktifkannya, pilih menu Windows > Properties. 
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g. Panel Library 

Seperti layaknya perpustakaan, library pada Flash berfungsi menampung 

semua simbol yang telah dibuat maupun hasil impor dari file luar seperti 

audio, video, gambar, dll.  Untuk menampilkan panel library,  bisa melalui  

menu Window > Library atau dengan menekan tombol CTRL+L. 

h. Panel Action 

Panel ini berfungsi sebagai tempat menuliskan ActionScript. Untuk 

mengaktifkannya, pilih menu Window > Action atau menekan tombol F9. 

 

2.5Android 

Nazaruddin (2012), Android merupakan sistem operasi untuk telepon seluler yang 

berbasis Linux. Android menyediakan platform terbuka bagi para pengembang 

untuk menciptakan aplikasi mereka sendiri untuk digunakan oleh bermacam 

piranti bergerak. Android umum digunakan di smartphone dan juga tablet PC. 

Fungsinya sama seperti sistem operasi Symbian di Nokia, iOS di Apple, dan 

BlackBerry OS. 

 

Terdapat beberapa versi Android seperti dibawah ini menurut ialah : 

1. Android versi 1.1  

Pada 9 Maret 2009, Google merilis Android versi 1.1. Android versi ini 

dilengkapi dengan pembaruan estetis pada aplikasi, jam alarm, voice search  

(pencarian suara), pengiriman pesan dengan Gmail, dan pemberitahuan email.  

2. Android versi1.5 

Pada pertengahan Mei 2009, Google kembali merilis telepon seluler dengan 

menggunakan Android dan SDK (Software Development Kit) dengan versi 

1.5 (Cupcake). Terdapat beberapa pembaruan termasuk juga penambahan 

beberapa fitur dalam seluler versi ini yakni kemampuan merekam dan 

menonton video dengan modus kamera, mengunggah video ke Youtube dan 

gambar ke Picasa langsung dari telepon, dukungan Bluetooth A2DP, 

kemampuan terhubung secara otomatis ke headset Bluetooth, animasi layar, 

dan keyboard pada layar yang dapat disesuaikan dengan sistem.  
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3. Android versi 1.6  

Donut (versi 1.6) dirilis pada September dengan menampilkan proses 

pencarian yang lebih baik dibanding sebelumnya, penggunaan baterai 

indikator dan kontrol applet VPN. Fitur lainnya adalah galeri yang 

memungkinkan pengguna untuk memilih foto yang akan dihapus pada 

kamera, camcorder dan galeri yang dintegrasikan pada CDMA. 

4. Android versi 2.0/2.1  

Pada 3 Desember 2009 kembali diluncurkan ponsel Android dengan versi 

2.0/2.1 (Eclair), perubahan yang dilakukan adalah pengoptimalan hardware, 

peningkatan Google Maps 3.1.2, perubahan UI dengan browser baru dan 

dukungan HTML5, daftar kontak yang baru, dukungan flash untuk kamera 

3,2 MP, digital Zoom, dan Bluetooth 2.1 

5. Android versi 2.2  

Pada 20 Mei 2010, Android versi 2.2 (Froyo) diluncurkan. Perubahan-

perubahan umumnya terhadap versi-versi sebelumnya antara lain dukungan 

Adobe Flash 10.1, kecepatan kinerja dan aplikasi 2 sampai 5 kali lebih cepat, 

intergrasi V8 JavaScript engine yang dipakai Google Chrome yang 

mempercepat kemampuan rendering pada browser, pemasangan aplikasi 

dalam SD Card, kemampuan WiFi Hotspot portabel,dan kemampuan auto 

update dalam aplikasi Android Market. 

6. Android versi 2.3   

Pada 6 Desember 2010, Android versi 2.3 (Gingerbread) diluncurkan. 

Perubahan-perubahan umum yang didapat dari Android versi ini, antara lain 

peningkatan kemampuan permainan, peningkatan fungsi copy paste ,layar 

antar muka didesain ulang, dukungan format video VP8 dan WebM, dan 

dukungan jumlah kamera yang lebih dari satu.  

7. Android versi 3.0   

Android Honeycomb dirancang khusus untuk tablet. Android versi ini 

mendukung ukuran layar yang lebih besar. User Interface pada Honeycomb 

juga berbeda karena sudah didesain untuk tablet . Honeycomb juga 

mendukung multi prosesor dan juga akselerasi perangkat keras (hardware) 

untuk grafis.  
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8. Android versi 4.0 

Diumumkan pada tanggal 19 Oktober 2011, membawa fitur Honeycomb 

untuk smartphone dan menambahkan fitur baru termasuk membuka kunci 

dengan pengenalan wajah, jaringan data pemantauan penggunaan dan kontrol, 

terpadu kontak jaringan sosial, perangkat tambahan fotografi, mencari email 

secara offline, dan berbagi informasi dengan menggunakan NFC.  

9. Android versi 4.1 ( Jelly Bean )  

Diumumkan pada tanggal 27 Juni 2012, Android versi Jelly Bean merupakan 

peningkatan dari versi sebelumnya, dimana pada versi ini fungsi dan kinerja 

antarmuka pengguna sudah ditingkatkan menjadi lebih baik lagi seperti 

antisipasi sentuh, triple buffering, perpanjangan waktu sync, dan peningkatan 

frame rate hingga 60fps untuk menciptakan tampilan yang lebih halus.  

10. Android versi 4.4 (  KitKat  )  

Diumumkan pada tanggal 3 September 2013 Android dengan versi  KitKat  

memiliki beberapa pembaruan antara lain Pembaruan antarmuka dengan bar 

status dan navigasi transparan pada layar depan, Optimasi kinerja pada 

perangkat dengan spesifikasi yang lebih rendah, Kerangka kerja pencetakan, 

NFC Host Card Emulation sebagai emulator kartu pintar, WebViews berbasis 

Chromium, Perluasan fungsionalitas bagi layanan pendengar notifikasi, API 

umum untuk mengembangkan dan mengelola klien pesan teks, kemampuan 

untuk menentukan aplikasi SMS standar, Kerangka kerja baru untuk transisi 

UI, Kerangka kerja akses penyimpanan untuk mengambil konten dan 

dokumen dari sumber lain yang saling terintegrasi. 
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2.5.1 Kelebihan Android 

Nazaruddin (2012) , dalam bukunya Hello Android, Operating System Android 

memiliki keunggulan antara lain : 

a. Sangat terbuka, development platform berbasis Linux dan Open source 

membuat para pembuat handset dapat mengeditnya tanpa membayar 

royalty.Developers menyukainnya karena mereka tahu bahwa platform ini 

“memiliki kaki” dan tidak terikat dengan vendor manapun yang dapat berada 

jauh dibawah ataupun diakuisisi. 

b. Arsitektur berbasis component yang terinspirasi dari kebebasan dunia internet. 

Bagian dari sebuah aplikasi dapat digunakan kembali dengan cara  yang tidak 

sama seperti apa yang dikembangkan developer. Ini akan membuat kreativitas 

baru di dalam dunia mobile. 

c. Grafis berkualitas tinggi dan suara halus, grafis vektor antialiased 2D dan 

animasi terinspirasi oleh Flash yang menyatu dengan 3Deaccelerated OpenGL 

grafis untuk memungkinkan jenis baru permainan dan aplikasi bisnis. Codec 

untuk standar industri yang paling umum, audio, dan video format yang 

dibangun di tepat dalamnya, termasuk H.264 (AVC), MP3, dan AAC. 

d. Memiliki portabilitas di berbagai perangkat keras saat ini dan masa depan. 

Semua program ditulis di Java dan dieksekusi oleh mesin virtual Android  

(Dalvik Android), sehingga kode Anda akan portabel di ARM, arsitektur x86, 

dan lainnya. Dukungan untuk berbagai masukan termasuk metode seperti 

keyboard, sentuhan, dan trackball. Antarmuka pengguna dapat disesuaikan 

untuk setiap resolusi layar dan orientasi. 

 

2.5.2 Kelemahan Android 

Andriyani (2016) menguraikan kekurangan Android adalah sebagai berikut : 

1. Koneksi Internet yang terus menerus. Kebanyakan ponsel Android 

memerlukan koneksi internet yang simultan atau terus menerus aktif, itu 

artinya anda harus siap berlangganan paket GPRS yang sesuai dengan 

kebutuhan dan batre yang boros karena GPRS yang terus menyala. 
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2. Iklan. Aplikasi di Ponsel Android memang bisa didapatkan dengan mudah 

dan gratis, namun konsekuensinya di setiap aplikasi tersebut, akan selalu ada 

iklan yang terpampang. 

 

2.6  Media Pembelajaran 

Sulianna (2014, p.6) menguraikan bahwa media pembelajaran terdiriatas dua 

unsur penting yaitu, unsur peralatan atau perangkat keras (hardware) dan unsur 

pesan yang dibawanya (message/software). Dengan demikian media pembelajaran 

memerlukan peralatan untuk menyajikan pesan, namun yang terpenting bukanlah 

peralatan itu , tetapi pesan atau informasi belajar yang dibawakan oleh media 

tersebut. Media pembelajaran dapat disimpulakan bahwa: 

a. Media pembelajaran adalah wadah dari pesan. 

b. Materi yang ingin disampaikan adalah pesan pembelajaran. 

c. Tujuan yang ingin dicapai adalah proses pembelajaran. 

 

2.7 Unifed Modeling Languange (UML) 

Rosa A. S. Dan M. Shalahuddin (2016). Unified Metodologi Language (UML) 

adalah Salah satu standar bahasa yang digunakan di dunia industri untuk 

mendefinisikan requirement, membuat analisis dan desain, serta menggambarkan 

arsitektur dalam pemograman berorientasi objek. 

 

2.8 Use Case Diagram 

Rosa A. S. Dan M. Shalahuddin (2016) mendefinisikan Use Case Diagram 

sebagai gambaran bagaimana seorang user berinteraksi dengan sistem dan 

mendefinisikan langkah-langkah yang diperlukan untuk mendapatkan hasil yang 

spesifik. 

Ada dua element utama pada use case Diagram yaitu pendefinisian actor dan use 

case 

a. Actor yaitu sebagai figur utama yang direpresentasikan sebagai seorang aktor 

yang dasosiasikan dengan satu kategori dari user atau elemen interkasi yang 

lain.  

b. Use Case digambarkan dengan bentuk oval. Dan digunakan untuk bertukar 

pesan yang disediakan oleh sistem. 
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Gambar 2.2 Elemen Utama Pada Use Case Diagram 

 

2.9 Sequence Diagram 

Rosa A.S dan M. Shalahuddin (2016), Sequence Diagram  menggambarkan 

kelakuan objek pada use case dengan mendeskripsikan waktu hidup objek dan 

message yang dikirimkan dan diterima antar objek. 

 

Dalam membuat Sequence Diagram harus memiliki acuan untuk melihat scenario 

yang ada pada use case. Banyaknya diagram sequen yang harus digambar adalah 

minimal sebanyak pendefinisian use case yang dimiliki pada setiap proses. 

Sehingga semakin banyak use case yang didefinisikan maka Sequence Diagram 

yang harus dibuat juga semakin banyak. 

Simbol-simbol Sequence Diagram dapat dilihat pada Tabel 2.1 berikut :  

 

Tabel 2.1 Simbol Sequence Diagram 

Simbol Deskripsi 

Garis hidup/lifeline 

 

 

Menyatakan kehidupan suatu objek. 

Objek  

 

 

Menyatakan objek yang berinteraksi 

pesan. 

Waktu aktif  

 

 

 

Menyatakan objek dalam keadaan aktif 

dan berinteraksi, semua yang terhubung 

dengan waktu aktif ini adalah sebuah 

tahapan yang  dilakukan di dalamnya. 

Pesan tipe create 

<<create>> 

 

Menyatakan suatu objek membuat objek 

yang lain, arah panah mengarah pada 

objek yang dibuat. 

nama objek : nama kelas 
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Pesan tipe call 

1 :  nama_metode() 

Menyatakan suatu objek memanggil 

operasi/metode yang ada pada objek 

lain atau dirinya sendiri. 

Pesan tipe send 

 

1 : masukan 

Merupakan bahwa suatu objek 

mengirimkan data/masukan/informasi 

ke objek lainnya, arah panah mengarah 

pada objek yang dikirim. 

Pesan tipe return 

 

1 : keluaran 

Menyatakan bahwa suatu objek yang 

telah menjalankan suatu operasi atau 

metode menghasilkan suatu kembalian 

ke objek tertentu, arah panah mengarah 

pada objek yang menerima kembalian. 

 

Simbol Deskripsi 

Pesan tipe destroy 

<<destroy>> 

 

 

 

Menyatakan suatu objek mengakhiri 

hidup objek yang lain, arah panah 

mengarah pada objek yang diakhirim 

sebaliknya jika ada create maka ada 

destroy. 

Aktor  

 

 

atau 

Orang, proses, atau sistem lain yang 

berinteraksi dengan sistem informasi 

yang akan dibuat di luar sistem 

informasi yang akan dibuat itu sendiri, 

jadi walaupun simbol dari aktor adalah 

gambar orang, tapi aktor belum tentu 

merupakan orang; biasanya dinyatakan 

menggunakan kata benda di awal frase 

nama aktor. 

 

2.10  Activity Diagram 

Rosa A.S dan M. Shalahuddin (2016), diagram aktivitas atau activity diagram 

menggambarkan workflow (alir kerja) atau aktivitas dari sebuah sistem atau proses 

bisnis atau menu yang ada pada perangkat lunak. Yang perlu diperhatikan disini 

adalah bahwa diagram aktivitas menggambarkan aktivitas sistem bukan apa yang 

dilakukan aktor, jadi aktivitas yang dapat dilakukan oleh sistem. 

Simbol-simbol yang ada pada diagram aktivitas dapat dilihat pada Tabel 2.3 

berikut ini : 

 

 

nama_aktor 
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Tabel 2.2 Simbol Activity Diagram 

Simbol Deskripsi 

Status awal 

 

Status awal aktivitas sistem, sebuah 

diagram aktivitas memiliki sebuah 

sistem awal. 

Aktivitas 

 

 

Aktivitas yang dilakukan sistem, 

aktivitas biasanya diawali dengan 

kata kerja. 

Percabangan/decision 

 

 

Asosiasi percabangan dimana jika 

ada pilihan aktivitas lebih dari satu. 

Penggabungan/join 

 

 

Asosiasi penggabungan dimana 

lebih dari satu aktivitas 

digabungkan menjadi satu. 

Status akhir Status akhir yang dilakukan sistem, 

sebuah diagram aktivitas memiliki 

sebuah status akhir. 

Swimlame 

 

 

 

Memisahkan organisasi bisnis yang 

bertanggungjawab terhadap 

aktivitas yang terjadi. 

 

2.11Prototype (Prototyping Model) 

Rosa A.S. dan M. Shalahuddin (2016), model prototype (prototyping model) 

dimulai dari mengumpulkan kebutuhan pelanggan terhadap perangkat lunak yang 

akan dibuat. Lalu dibuatlah program prototype agar pelanggan lebih terbayang 

dengan apa yang sebenarnya  diinginkan. Program prototype biasanya merupakan 

program yang belum jadi. Program ini biasanya menyediakan tampilan dengan 

simulasi alur perangkat lunak  sehingga tampak seperti perangkat lunak yang 

sudah jadi. Program prototype ini dievalusai oleh pelanggan atau user sampai 

ditemukan spesifikasi yang sesuai dengan keinginan pelanggan atau user. Berikut  

ini adalah gambar dari model prototype : 

aktivitas 

nama swimline 
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             Gambar2.3Ilustrasi Model Prototipe 

Mock-up adalah sesuatu yang digunakan sebagai model desain yang digunakan 

untuk mengajar, demonstrasi, evaluasi desain, promosi, atau keperluan lain. 

Sebuah mock-up disebut sebagai prototype perangkat lunak jika menyediakan atau 

mampu mendemonstrasikan sebagian besar fungsi sistem perangkat lunak dan 

memungkinkan pengujian desain sistem perangkat lunak. 

 

Proses pada model prototyping dapat dijelaskan sebagai berikut : 

a. Mendengarkan Pelanggan  : Developer dan klien bertemu dan menentukan 

tujuan umum, kebutuhan yang diketahui dan gambaran bagian-bagian yang 

akan dibutuhkan berikutnya oleh pelanggan. 

b. Membangun dan memperbaiki Mock-up : Perancangan dilakukan cepat dan 

rancangan mewakili semua aspek perangkat lunak yang diketahui, dan 

rancangn ini menjadi dasar pembuatan prototype. 

c. Melihat dan Menguji Evaluasi prototype : Klien mengevaluasi prototype yang 

dibuat dan digunakan untuk memperjelas kebutuhan perangkat lunak. 

Perulangan ketiga proses ini terus berlangsung hingga semua kebutuhan 

terpenuhi. Prototype-prototype dibuat untuk memuaskan kebutuhan klien dan 

untuk membangun perangkat lunak lebih cepat, namun tidak semua prototype 

bisa dimanfaatkan. Demi kebutuhan klien lebih baik prototype yang dibuat 

diusahakan dapat dimanfaatkan. 

 

2.12  Pendidikan Groundstaff 

Membangun/ 

Memperbaiki 

Mock-up 

Pelanggan 

Melihat dan 

Menguji Mock-

up 

Mendengark

an Pelanggan 
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Groundstaff adalah staf di sebuah maskapai penerbangan yang memiliki tugas 

antara lain ground handling, cargo handling, dan ticketing. Selain profesi 

pramugari/ra, ground staff adalah komponen penting dalam kegiatan operasional 

penerbangan. Bisa dikatakan, ground staff adalah pramugari dan pramugara 

maskapai selama di darat. 

 

Lebih detail tugas Ground Staff adalah menangani bagasi penumpang, menangani 

kargo pesawat, melakukan loading dan unloading pesawat, membantu penumpang 

dalam proses check in, boarding, dan disembarking, menyapa penumpang 

sebelum memasuki pesawat, dan menangani penjualan tiket. Untuk menjadi 

seorang ground staff dibutuhkan pengetahuan dunia penerbangan, keahlian 

customer service dan complaint handling, penguasaan Bahasa Inggris untuk dunia 

penerbangan, dan banyak lagi. Semua keahlian dan pengetahuan mengenai ground 

staff ini, dapat Anda dapatkan di Program Pendidikan dan Pelatihan Ground Staff 

CAT Bandar Lampung. 

 

Program Pendidikan dan Pelatihan Ground Staff CAT menggunakan kurikulum 

yang disusun secara cermat dan proporsional yang dapat ditempuh selama kurun 

waktu 6 bulan, dan disertai dengan berbagai macam kompetensi penunjang 

sehingga dapat memberikan wawasan yang menyeluruh kepada Anda mengenai 

dunia penerbangan, khususnya profesi ground staff. Dan pada akhirnya output 

atau lulusan dapat bersaing dan lolos tes dan dapat bergabung di salah satu 

maskapai penerbangan besar lokal maupun internasional 

 

2.12.1 Aviation Security (AVSEC) 

Aviation Security adalah personil keamanan penerbangan yanng telah 

memiliki lisensi atau surat tanda kecakapan petugas (STKP) yang diberi 

tugas dan tanggung jawab di bidang keamanan penerbangan.  

 

Pengertian avsec sendiri di indonesia yaitu pengaman bandar udara adalah 

sebuah unit kerja yang dibentuk oleh PT.Angkasa Pura dalam memenuhi 
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aturan aturan nasional dan internasional sebagai pengelola dan penyedian 

jasa keamanan bandara. 

 

Sejarah AVSEC (Aviation Security) setelah dikenal sejak abad 20 ketika 

terjadi pembajakan pesawat udara di Peru tahun 1931. Kejadian ini 

merupakan tindak kejahatan (melawan hukum) diudara yang pertama 

terhadap penerbangan sipil yang kemudian terjadi berulang-ulang menimpa 

berbagai penerbangan sipil. 

 

Setelah kejadian tersebut AVSEC diberikan tugas pokok untuk menjamin 

keamanan dan keselamatan penerbangan sipil di Indonesia dari tindakan 

melawan hukum dan juga memberikan perlidungan keamanan terhadap 

awak pesawat udara, pesawat udara, penumpang, instalasi bandar udara, 

para petugas di darat, masyarakan dan pengguna jasa penerbangan lainnya 

dari tindakan melawan hukum. 

 

Tujuan sistem pengamanan bandar udara adalah  dalam UU Nomor 15 tahun 

1992 tertanggal 25 Mei 1992 tentang penerbangan, yang terkait dengan 

pengamanan (Security) bandar udara yaitu Bab VIII pasal 3 yang berbunyi: 

“Penyelenggaraan bandar udara bertanggung jawab terhadap keamanan 

dan keselamatan penerbangan serta kelancaran pelayanannya”. 

 

2.12.2 PASASI GUIDLINES  

pasasi sendiri dapat diartikan sebagai ground handling yaitu staff-staff yang 

ada di airport yang memproses mulai dari pembelian tiket, pencetakan 

boarding pass, absensi dalam ruang tunggu, pengaturan beban bagasi, 

penata letakan bagasi dalam pesawat, penangaanan masalah ketika pesawat 

itu mengalami delay. Dalam artian luas front liner sebuah maskapai 

penerbangan atau lebih dikenal sebagai ujung tombak majunya sebuah 

perusahaan penerbangan. 
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Dalam setiap perusahaan penerbangan memiliki pasasi yang di tempatkan 

dalam beberapa departemen yang menangani bidangnya masing2 dan saling 

mengisi sehingga dapat dinikmati oleh masyarakat yang menggunakan 

transportasi udara. 

Pasasi sendiri terdiri dari : 

Untuk front liner terdiri dari : 

1. Check in counter 

2. Help desk 

3. Custmmer service  

4. Marssal  

 

 

 

 

Untuk back liner terdiri dari : 

1. Boarding gate 

2. Corridor  

3. Loast and found 

4. Tag collector  

5. Gendec maker 

6. Transfer desk 

7. Dopros (dokumen proses) 

 

2.12.3 Baggage Handling  

Baggage handling (bagasi penumpang) adalah barang bawaan penumpang 

yang akan dibawa pada saat melakukan penerbangan. Baggage handling 

sendiri dibagi menjadi 2, yaitu : 

a. Hand Baggage  

Hand baggage adalah barang bawaan penumpang diperbolehkan 

masuk kedalam cabin pesawat dengan syarat baggage tersebut 

tidak lebih dari 7kg.   

b. Checked baggage  
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Checked baggage adalah bagasi tercatat yang harus dibawa 

penumpang dan harus di check-in kan kepada petugas check-in 

counter. 

 

 2.12.3.1 Tujuan Dari Baggage Handling adalah  

Tujuan utama baggage handling adalah proses dimana bagasi milik 

penumpang harus diangkut bersama dalam satu pesawat dengan 

penumpangnya. 

 

Harus di ingat bila bagasi tersebut tidak dapat di angkut dengan peswat 

yang sama maka akan menimbulkan hal yang serius kepada penumpang 

karna akan merasa kecewa. Tujuan akhhirnya adalah custommer 

satisfaction , yaitu kepuasan pelanggan dalam hal ini adalah penumpang 

dan pihak airlines. 

 

2.12.4 Customer Service 

Customer service adalah setiap kegiatan yang ditujukan untuk memberikan 

kepuasan melalui pelayanan yang diberikan seseorang kepada kliennya 

dalam menyelesaikan masalah dengan memuaskan. Pelayanan yang 

diberikan termasuk menerima keluhan atau masalah yang sedang dihadapi. 

 

2.12.4.1 Berikut ini tugas dan fungsi dari customer service 

Tugas dan fungsi customer service adalah seorang customer service harus 

pandai dalam mencari jalan keluar untuk menyelesaikan berbagai masalah-

masalah yang dihadapi oleh pelanggan atau tamunya. Tugas customer 

service yaitu memberikan pelayanan yang prima dan membina hubungan 

baik dengan nasabah, klien atau pelanggan. Seorang customer rervice juga 

harus bertanggung jawab dari awal sampai akhir dari pelayanan tersebut. 

Customer service juga berfungsi untuk: 

a. Penerima Tamu – Dalam hal ini Seorang customer service melayani 

pertanyaan-pertanyaan yang diajukan tamu serta memberikan informasi yang 

diinginkan selengkap mungkin secara ramah, sopan, menarik dan 
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menyenangkan. Harus selalu memberi perhatian, bicara dengan suara jelas 

serta lembut, dan memakai bahasa yang mudah dimengerti klien. 

b. Customer Relation Office – Artinya bahwa customer service yaitu 

orang yang dapat membina hubungan baik dengan klien/pelanggan. 

Sehingga merasa puas, senang, dan juga semakin percaya. Customer 

service harus menyiapkan formulir ataupun brosur untuk tamu/klien, 

serta ikut membantu mengisi formulir. 

c. Komunikator – Dengan cara memberikan berbagai informasi dan 

kemudahan-kemudahan kepada tamunya, juga sebagai tempat 

menampung berbagai macam keluhan, keberatan ataupun sebagai 

tempat konsultasi. 
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2.13 Penelitian Terdahulu 

Tabel 2.3 berikut adalah tabel penelitian terdahulu terkait dengan media 

pembelajaran: 

Tabel 2.3 penelitian terdahulu 

Nama Judul Terbit/Tahun Uraian 

Ali 

Muhson 

Pengembangan media 

pembelajaran  berbasis 

teknologi informasi 

Jurnal 

Pendidikan 

Akuntansi 

Indonesia, Vol. 

VIII. Tahun 

2010 

Media pembelajaran berbasis TI 

dapat merupakan wahana penyalur 

pesan dan informasi belajar. Media 

pembelajaran yang dirancang 

secara baik akan sangat membantu 

peserta didik dalam mencerna dan 

memahai materi pelajaran. Di era 

globalisasi dan informasi ini, 

perkembangan media pembelajaran 

juga semakin maju. Penggunaan 

teknologi informasi (TI) sebagai 

media pembelajaran sudah 

merupakan suatu tuntutan. 

Walaupun perancangan media 

berbasis TI memerlukan keahlian 

khusus, bukan berarti media 

tersebut dihindari dan ditinggalkan. 

Media pembelajaran berbasis TI 

dapat berupa internet, intranet, 

mobile phone, dan CD Room/Flash 

Disk. Adapun komponen utamanya 

meliputiLearning Management 

System (LMS),  
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Tabel 2.3 (Lanjutan) 

Ramos 

Somya 

Pembuatan Media 

Pembelajaran Dasar 

Bahasa Korea 

Menggunakan 

AndEngine Berbasis 

Android 

 Bahasa Korea saat ini menjadi 

salah satu bahasa asing yang 

diminati untuk dipelajari oleh 

masyarakat Indonesia. Hal ini 

merupakan dampak dari masuknya 

Hallyu (Korean Wave) di 

Indonesia. Namun saat ini media 

pembelajaran bahasa Korea masih 

kurang interaktif karena 

keterbatasan sarana misalnya buku, 

dibandingkan dengan aplikasi 

mobile yang memiliki desain yang 

menarik dan fasilitas audio. 

Berdasarkan masalah tersebut 

dibuat aplikasi pembelajaran dasar 

bahasa Korea menggunakan 

AndEngine berbasis Android. 

Dalam pengembangan aplikasi ini 

digunakan library AndEngine dan 

memanfaatkan ekstensi 

accelerometer yang dimiliki oleh 

AndEngine. Dengan adanya 

aplikasi ini, para pengguna bisa 

belajar berbagai macam huruf 

bahasa Korea dan cara 

membacanya dengan lebih 

menyenangkan, karena aplikasi 

juga dilengkapi dengan mini game. 
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Tabel 2.3 (Lanjutan) 

Iwayan S Rancang Bangun 

Aplikasi 

Pembelajaran 

Untuk Anak Umur 

6-9 Tahun 

Berbasis Android 

E-Jurnal Teknik 

Informatika, 

Volume 7, 1 

Januari 2016, 

ISSN 2301-

8364 

Bahasa inggris merupakan 

bahasa international yang 

kerap digunakan diberbagai 

bidang, misalnya dibidang 

pendidikan. Pengetahuan 
tentang bahasa inggris sudah 

diajarkan sejak dari sekolah 

dasar, tetapi tidak banyak 

dari anak – anak terlebih 

khusus anak usia 6 – 9 tahun 

untuk mudah mengerti 

tentang pengetahuan bahasa 

inggris. Terkadang orang tua 

rela mengeluarkan uang 

lebih untuk memberikan 

pelajaran khusus diluar 
sekolah seperti kursus untuk 

memberikan pengetahuan 

lebih tentang bahasa inggris 

kepada anak mereka. Pada 

perkembangan teknologi 

informatika terlebih 

khususnya pada teknologi 

smartphone  yang bersistem 

operasi Android telah 

banyak menyediakan 

beberapa macam aplikasi 

yang bisa mempermudah 

pekerjaan manusia sehari – 

hari. Tetapi banyaknya 

aplikasi yang beredar 

sekarang lebih didominasi oleh 

aplikasi yang diperuntukan 

kepada orang dewasa, 

sedangkan aplikasi yang 

dikhususkan untuk anak usia 

6 – 9 tahun masih tergolong 

sedikit dan materi edukasinya 

terbatas dalam bidang 

pendidikan khususnya 

aplikasi pembalajaran bahasa 

inggris. Tujuan penelitian ini 

adalah untuk merancang dan 

membangun aplikasi 

pembelajaran bahasa inggris 

untuk anak usia 6 – 9 tahun 

yang menarik, interaktif dan  
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Tabel 2.3 (Lanjutan) 

   mampu memberikan 

pengetahuan lebih tentang 

bahasa inggris. Aplikasi ini 

berbasis Android dengan 

menggunakan metodologi 

Multimedia Development Life 

Cycle. Tahapan pada metodologi 

multimedia antara lain concept, 

design, material collecting, 

assembl, testing, dan 

distribution. Aplikasi 

pembelajaran yang dihasilkan 

mampu memberikan tambahan 

pengetahuan materi 

pembelajaran bahasa inggris dan 

mampu digunakan dengan baik 

oleh anak usia 6 – 9 tahun 

dengan syarat harus dibimbing 

oleh orang tua pada awal 

penggunaan aplikasi. 

Danny 

Abrianto 

Penggunaan 

Media 

Pembelajaran 

Berbasis 

Komputer dan 

Sikap Inovatif 

Terhadap Hasil 

Belajar 

Teknologi 

Informasi dan 

Kounikasi 

Jurnal 

Teknologi 

Informasi & 

Komunikasi 

dalam 

Pendidikan, 

Vol 1, No. 1, 

Juni 2014, p-

ISSN 2355-

4983. 

Penelitian ini bertujuan untuk 

mengetahui keunggulan 

penggunaan media pembelajaran 

radio streaming dibandingkan 

dengan komputer dalam 

mempengaruhi hasil belajar 

TIK, untuk mengetahui hasil 

keunggulan TIK siswa yang 

memiliki sikap inovatif positif 

lebih tinggi dibandingkan 

dengan sikap inovatif negatif;   
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Tabel 2.3 (Lanjutan) 

   interaksi antara media 

pembelajaran radio streaming  dan 

komputer dengan sikap inovatif 

siswa dalam hasil belajar TIK.  

Metode penelitian menggunakan 

metode quasi eksperimen dengan 

desain penelitian faktorial 2x2, 

sedangkan teknik analisis data 

menggunakan ANAVA dua jalur 

Hasil penelitian diperoleh bahwa; 

hasil belajar TIK siswa yang 

dibelajarkan dengan menggunakan 

media pembelajaran radio 

streaming lebih tinggi 

dibandingkan dengan computer, 

hasil belajar TIK siswa yang 

memiliki sikap inovatif positif lebih 

tinggi daripada sikap inovatif 

negative, terdapat interaksi antara 

media pembelajaran radio 

streaming dalam pembelajaran 

dengan sikap inovatif siswa, artinya 

bahwa siswa yang memiliki sikap 

inovatif positif dengan 

menggunakan media pembelajaran 

radio streaming maupun komputer 

akan memiliki hasil belajar TIK 

lebih tinggi dibandingkan dengan 

siswa yang memiliki sikap inovatif 

negatif.  
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